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Introduction 

What is RADlite? 
The RADlite is a comprehensive image and video manipulation system that 
can be controlled by any DMX lighting desk or PC. It combines large numbers 
of images and digital videos with vector shapes, colour backgrounds, text 
messages and even live input. The results are spectacular and the 
possibilities are infinite. 
 
The RADlite comes with a comprehensive library of graphics, palettes, shapes 
and videos, but adding your own could not be simpler. The system has been 
designed to grant the user total control over their display.  Whatever you put in 
to the software, be that unique graphics or videos, or just your own palettes to 
help match the RADlite display to your other lights, will enable you to create a 
personalised display that is a unique to you. 
 
The real beauty of the RADlite, is that it allows you to modify your display in 
‘real time’.  This means that, in addition to running video or pre-programmed 
sequences, you can add extra text, graphics, colours etc. instantly for 
immediate impact.  
 
A hugely versatile product, the RADlite can be used to control any video 
display accepting SVGA, s-video or composite signals. This includes most 
LCD and DLP projectors, video walls and plasma screens and can be used in 
a wide variety of resolutions and aspect ratios.   
 



 

 
The RADlite system can be controlled from the same controller as any other 
lights and behaves in a very similar way to a moving light. 
 
The signal from the desk is sent to the RADlite box via a DMX to Ethernet 
converter. The RADlite instantly performs the task it has been asked to do and 
displays the result on the display device, which can be a projector, plasma 
screen, or any other video display device you should choose. 
 
 

Features 
As the RADlite behaves as much like a moving light as possible, it has been 
divided up into separate fixtures. These are as follows: 
RLcanvas is concerned with the background layer. Video, trails and 
background colour are all controlled from this fixture 
RLgraphics is the fixture concerned with images, shapes and palettes. 
Several layers of graphics can be patched into one show. This works by giving 
precedence to the latest layer. 
RLmask can also be used more than once in each show. This fixture works 
by creating a mask and allowing rotation and movement of that shape as well 
as several other features 
RLtext is yet another layerable fixture. Create text in the control panel and 
add effects. 
RLsurface can be used in conjunction with RLcanvas and RLgraphics. It 
allows the video or image to be mapped onto a set of surfaces, including 3D 
surfaces. These surfaces can then be manipulated on the x, y and z-axis and 
manipulated for key-stoning purposes. 
RLwave is another multilayer fixture. Using any Windows audio device a 
sound wave can be created. There are several modes of waves that can be 
positioned, coloured and rotated. 
Rlparticle is a new RADlite fixture to version 4.3. Create unique moving 
imagery using age, weight, gravity and spread functions. Create anything from 
explosions to clouds without the need for expensive video clips. The particles 
create abstract, organic patterns. 
RS232 devices enables the user to utilise any RS232 controllable devices 
such as projectors and video switches and control them from the desk along 
with the other fixtures. For example, selecting the Kramer video matrix from 
the library allows you to switch between live video sources. For example, if 
there are eight different camera feeds in the show, then the RADlite can be 
used to switch between these. Please note that the Kramer video matrix 
hardware must be attached to the RADlite. 
 
All of this, controlled in real time, means thousands of stunning visual effects 
from just one application. 
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Typical Uses 
 
The RADlite is an astonishingly versatile product that can be as simple or 
sophisticated as you need it to be.  It has countless uses in a countless 
number of events and displays. In stage shows or rock concerts the RADlite 
can be used as an effect light, or to create stunning projected displays of 
graphics, text and video (or all three at once).  Because of its many layers, 
one RADlite is capable of doing the work of several video / projector units. 
 
The RADlite also works well in corporate or leisure spaces.  It can be used to 
add light and movement to your environment in as subtle or spectacular way 
as you choose.  Projected onto a screen or television it becomes a fabulous 
‘wow feature’, displaying moving art or a ‘live’ notice / message board.   
 
If you want to create a professional light or projected display on a product that 
is simple to use, then the RADlite is for you.  TV Studios, exhibitions, shops, 
theatres, nightclubs, offices and conference centres have all benefited from 
the RADlite’s unique abilities. 
 
The RADlite system can be used in conjunction with its sister product, 
PixelDrive enabling you to match your led display to match exactly to your 
video display. 
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2 
Installation and setup 

If you chose the pre-built system, your RADlite comes pre-
installed – it should simply be a matter of plugging it in. This 
chapter shows how to connect you RADlite to external 
equipment and describes the uses of the various files and 
directories that the system uses.. 

 If you have the software only version, then the following 
information will help you to optimise your hardware to run 
RADlite. 

Hardware set up 
Your RADlite system should come complete with the following: 
1 4u rack mountable PC with DVDRW 
1 mouse 
1 keyboard 
1 TV out lead 
1 VGA splitter 
1 DVI to VGA converter 
Windows XP Pro / 2000 
All software associated with The RADlite system 
DMX to Ethernet converter 
 
If you choose the software only option for your RADlite system here are some 
hints on what hardware set up you should use: 
 
Standard System: Best for general use of video and graphic effects 
 

• Dual AMD Athlon MP 2.8+Ghz processors / Dual Intel 2.8 Ghz Xeon 
processors 

• Dual processor supporting motherboard 
• Dual / triple output Nvidia Graphics Card  
• Winnov Videum capture card 



 

• 200Gb + Hard Disk Drive  
• DVD writer 
• Floppy Disk Drive 
• Standard 10/100 Network card 
• 1Gb RAM 
• Windows XP Pro 

 
Professional System: Best for high video usage and NG1 

• Dual Intel 3.4 Ghz Xeon processors 
• Dual processor supporting motherboard 
• Dual / triple output  Nvidia Graphics Card  
• Winnov Videum capture card 
• 250Gb + Hard Disk Drive  
• DVD writer 
• Floppy Disk Drive 
• Standard 10/100 Network card 
• 2Gb RAM 
• Windows XP Pro  

 
 
You will also need: 
A DMX controller (lighting desk) 
A DMX cable 
A monitor 
An output device (projector, screen, TV etc..) 
Ethernet cross-over cable 
DMX to Ethernet converter (ArtNet compatible) 
 
To set up the equipment so that your RADlite is working correctly, please 
follow the instructions below. 
 

• Connect the mouse and keyboard to the colour co-ordinated slots in 

the back of the rack mountable case. 

• Connect the DVI adapter to the bottom of the two graphics output slots. 

• Connect the monitor lead to this adapter 

• Connect the TV out lead to the top of the two graphics output slots. 

• Connect the splitter lead to the TV out lead for VGA output and use 

Adapter 1 for any VGA output device 

• Alternatively, connect the output device to either the S-Video or 

Composite connector on the TV out lead directly. 

• Insert one end of the Ethernet crossover cable in to the slot at the back 

of the RADlite, and the other end into the ArtNet device. 
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• Connect the power supply for both the RADlite and the ArtNet device 

using the correct power leads and ensure the voltage is set correctly if 

your RADlite has a switching voltage. 

• Connect the DMX control device to a power supply and monitor if 

required. 

• Attach the DMX cable between the desk and the ArtNet device.  

• Power up the controller, the ArtNet device, the output device and finally 

the RADlite PC itself . 

System files 
These are found in the R43 directory in the C: ProgramFiles/Radical 
Lighting\RADlite43 folder if you installed the software accepting all the 
defaults. 
 

Registration 
 

 
 
RADlite software is now distributed with a USB dongle. This dongle must be in 
the PC before the RADlite program is opened, otherwise you will see a “Dinky 
Dongle” error. 
The dongle should be left in the PC all the time or assigned to a responsible 
person. If the dongle is lost this may result in having to re-purchase the 
software. 
This may seem extreme but it is a standard way of protecting software. You 
can request a serial dongle upon order if you feel the USB dongle mey be too 
fragile or easily lost. 
Using a dongle for security will allow you to build back up systems without 
having to purchase multiple copies of the software. The dongle acts the same 
way as the serial number in previous versions. 
 

Configuration utilities 
Your RADlite system comes preloaded with various utilities as follows: 
 
AMCap 
This is related to the RADlite’s capture capability. Run AMCap only if you are 
having problems with capture. 
 
JMStudio 
JMStudio is related to the RADlite’s video output. It can be used to convert 
video files to Cinepak if necessary. 
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3 
Basic operation 

A brief overview of how the RADlite works.  

 

Getting Started 
There should be a Ralite icon on the desk top that you can double click to 
activate the program. If not then go to the start menu and go to Radical 
Lighting/Radlite 43.  
The last saved show will automatically load up. To begin a new show, choose 
New from the File menu. 
This will allow you to choose the fixtures that you want. Remember that the 
order in which they are displayed in the patch window is important. The 
canvas or background layer defaults to level 0, which is actually black, 
meaning that if this is the top layer, nothing underneath can show through. 
This only happens with the background layer. 
Graphic layers, masks, particles, waves, RS232 and text can all be patched in 
any number of times and the lowest in the list will take precedence in the 
display.  
 
Once you have successfully chosen the fixtures required, the software can 
then either be controlled locally using the faders under the preview monitor, or 
the fixtures can then be patched into the desk using a personality file. This is 
done using the personalities found in the Lib folder. Most lighting desks will 
have all the RADlite fixtures already within their libraries. The dmx addresses 
are found on the left hand side of the control panel. Should these need to be 
changed they can, with a simple change of number in the same window. 
 
The RADlite Control Panel is the key to using the RADlite. Once you are 
familiar with this, and you are familiar with lighting desk operation, it will 
become second nature. There are many parameters, but practice makes 
perfect! 
 

Adding files to the library 
There are several libraries associated with the RADlite software; video, 
images, shapes, palettes, particles and messages. 



 

To add new files to these libraries, they must first be copied into the RADlite 
library folder using Microsoft Windows. This should be on C:/program 
files/radical lighting/radlite43/lib 
Once the file has been placed in the correct, then in the Media window, select 
either the video, graphics, palettes, particles or shapes buttons. 
A display of the files already loaded into the RADlite can be seen within the 
window.  
Press the + key to add new files. Pressing this will make a directory tree 
appear. Providing you have placed the file in the correct place, you can select 
it here. Once you have selected the correct files and said OK, it will be 
available in the relevant RADlite fixture’s parameters.  
Please note, multiple files can be added to the RADlite show at the same 
time, there is no need to say OK after selecting individual images etc. 
 
To add new text messages to the system, the process is even simpler. Press 
the + key and fill in the message name box that appears. Then type in the text 
you want in the Media Widow. You can choose font, size, bold, italic etc from 
this window.  
 
To remove files, simply select them from the Media Window and press the – 
key. 
 
Please note that the system may allow you to import the wrong file type into a 
library, which will result in an error when running the system. A warning 
message should be displayed informing you of the error. 

 

The RADlite Fixtures 
As mentioned in the last section, becoming familiar with the parameters is the 
key to becoming a proficient RADlite user. This section is a brief overview of 
what each parameter is and what it does.  We recommend that you focus on 
familiarising yourself with the actual RADlite parameters before you begin to 
use the RADlite with DMX control. 
Select individual fixtures in the RADlite control window and the parameters 
and local faders will appear underneath the preview monitor. Ensure that you 
have selected Local control by selecting the Configure menu and choosing 
DMX.  
Please note some fixtures  can be added as either standard fixtures or as 16-
bit fixtures, where pan, tilt, zoom and rotation are 16-bit parameters. With the 
standard fixtures, each parameter is 8-bit with the exception of rotation in all 
fixtures and position in RLcanvas, which are 16. This means that each 
parameter can contain any value between 0 and 255. They are described in 
percentage terms below with the 0% representing the 0 value and the 255 
value being represented by 100%. 
 
Below is a description of each RADlite fixture and a full list of all the 
parameters it contains: 
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RLCanvas  

 
Level This is essentially the dimmer control. It will default to 0 %, 

which means it is black. Remember to increase this level to be 
able to see the output. 

Wipe   These are  transitions that can be used between video clips.  
Wipe speed  This parameter controls the speed of the wipe with 0 being off 

and 100 being the fastest speed. 
Trail The trail parameter is the effect of any moving part of the display 

leaving a shadow, or trail behind. This controls the length of time 
the trail is visible. 100% is constant, 0 is off. 

Mode* When video is playing, there are several modes which it can 
interact with other layers in the display. This parameter controls 
which one of these modes is used. The default value is 0%, 
which is no effect.  

 
*Here is a brief explanation of how the 12 video modes work -  
 
The first five video attributes ignore all the graphic layers and only use the 
colour setting in RLCanvas, as follows: 
 
1. SCALE   (this is like putting a bit of Gel in front of the video) 
2. AND    (posterising effect) 
3. OR    (The darker the colour the more video gets through) 
4. Exclusive OR  (invert) 
5. ADD   (wacky, messy and hard to control...but fun) 
 
The next five are the same as 1-5 but use the graphic layers as well as the 
colour setting. This makes it easier to just apply colour tinting to videos 
without having to mess around with several layers. 
 
6. SCALE 
7. AND 
8. OR 
9. Exclusive OR 
10. ADD 
 
Mode 11  enables you to display a solid graphic on top of video. 

This works by letting the video though any areas that are 
set to the background colour (in RLCanvas). So,  if you 
see bits of video leaking through a graphic then you can 
fix this by changing the Colour mix in Canvas (treat it like 
a chroma key). 

 
Mode 12  is a Straight A/B mix of video and graphics. The more you 

turn the video level down the more the graphics become 
visible. 
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Video This parameter chooses which video to play from the library of 
videos in the RADlite system. Up to 255 video clips can be 
stored in any one video library. 

Speed Again, concerning video; this parameter allows control of speed 
of playback of the playing video. 

Position This allows the user to shuttle between different frames of the 
playing video. 

Red  The red component of the canvas layer. 
Green  The green component of the canvas layer. 
Blue  The blue component of the canvas layer. 
 
 

PixelDrive  (For use with PixelDrive system only) 
 
Level  This is the master intensity of output to the Pixel Range fixtures 
Trails The trail parameter is the effect of any moving part of the display 

leaving a shadow, or trail behind. This controls the length of time 
the trail is visible. 100% is constant, 0 is off. Within this fixture, it 
is used specifically within the PixelDrive system. 

Effect 1 Choose from the internal effects of the Pixelline 1044 
Speed 1 Select the speed of effect 1. 
Xfade 1 Select the cross fade of effect 1. 
Effect 2 Choose the second effect from the internal effects of the 

Pixelline 1044 
Speed 2 Select the speed of effect 2. 
Xfade 2 Select the cross fade of effect 2. 
 

PixelDriveM2  (For use with PixelDrive system only) 
Level  This is the master intensity of output to the Pixel Range fixtures 
Trails The trail parameter is the effect of any moving part of the display 

leaving a shadow, or trail behind. This controls the length of time 
the trail is visible. 100% is constant, 0 is off. Within this fixture, it 
is used specifically within the PixelDrive system. 

Effect 1 Choose from the internal effects of the Pixelline 1044 
Speed 1 Select the speed of effect 1. 
Xfade 1 Select the cross fade of effect 1. 
Effect 2 Choose the second effect from the internal effects of the 

Pixelline 1044 
Speed 2 Select the speed of effect 2. 
Xfade 2 Select the cross fade of effect 2.  
Preset Version 4.3 has the ability to record cues and basic chases from 

the software. Playback all stored presets using this parameter 
Red  The red component of the background. 
Green  The green component of the background. 
Blue  The blue component of the background. 
. 
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RLGraphics (multi layer fixture) 

 
Level The brightness control. It will default to 0 %, which means it is 

off. Remember to increase this level to be able to see the output. 
If this level is toggled somewhere between 0 and 100, the layer 
beneath will become more or less visible. 

Image This contains all of the images that you have imported into the 
RADlite system. The first image in the library will be given the 
value 0% and the last is 100%.  

Shape This contains the all the shapes you have in the shape library. It 
determines the shape you want to draw the image or colour 
background in. Again, the first shape is 0% and the last 100%. 
There does not need to be 100 shapes, there can be any 
number between 1 and 255 shapes, images, palettes etc. 

Width This is the option to draw the image or color fill rather than fill it. 
0% is filled, 1 – 100% are the actual pixel width of the line 

X  The position of the image and/or shape on the x axis 
Y  The position of the image and/or shape on the y axis 
Zoom  Defaults to 50%. 51 – 100% is zoom in and 0-49% is zoom out. 
Aspect Also defaults to 50 which is static. 0-49% is the horizontal aspect 

and 51-100% is the vertical aspect. 
Rotation 0% is static, 0-49% are angles between 0 and 360°, 50-74% is 

clockwise rotation of varying speed and 75-100% is anti-
clockwise rotation of varying speed. 

Red1 The Red component of the first colour of a gradation. 100% is 
full red. 

Green 1 The green component of the first colour of a gradation. 
Blue 1 The blue component of the first colour of a gradation. 
Red 2  The Red component of the second colour of a gradation.  
Green 2 The green component of the second colour of a gradation. 
Blue 1 The blue component of the second colour of a gradation. 
Colour The choice of colour palettes from the palette library. 
Div The frequency of the gradation. I.e. blue to red, or blue to red to 

blue to red to blue to red etc. 
Speed The speed at which the palette cycles between its individual 

colours. 0% is static, 100% is the fastest cycling speed. 
Fx  To be implemented at a later date 
Fx Depth The prism depth, i.e. distance between facets. 
Fx Size The number of facets used in a prism. 
Fx Rot To be implemented at a later date. 
 
 

RLText (multi layer fixture) 
 
Level  Adjusts the brightness of the text. 
Text  This contains the all the text files you have in the text library. 
Shadow Variable size drop shadow at various angles. 
X  The x position of the text. 
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Y  The y position of the text. 
Zoom  Defaults to 50%. 51 – 100% is zoom in and 0-49% is zoom out. 
Aspect Also defaults to 50 which is static. 0-49% is the horizontal aspect 

and 51-100% is the vertical aspect. 
Rotation Rotation of text as with other fixtures. 
Red   Red component of text colour. 
Green  Green component of text colour. 
Blue  Blue component of text colour. 
 
 

RLMask  (multi layer fixture) 

 
Level Adjusts the opacity of the mask. 0% is fully transparent and 

100% is fully opaque. 
Mask  Picks a mask shape from the shape library. 
X  Choose the x position of the mask. 
Y  Choose the y position of the mask. 
Zoom  As in RLgraphic. 
Aspect As in RLgraphic. 
Rotation As in RLgraphic. 
Red  The red component of the mask background. 
Green  The green component of the mask background. 
Blue  The blue component of the mask background. 
 
 
RLSurface 
 
Shape Choose the shape you would like to display the video or image 

on. 
X   The x position of the shape 
Y  The y position of the shape 
Zoom  Defaults to 50%. 51 – 100% is zoom in and 0-49% is zoom out. 
Rotate X Rotation on the x-axis. 0 – 50% is position, 51-75% clockwise 

rotation and 76-100% anticlockwise rotation. 
Rotate Y Rotation on the y-axis. As rotate x. 
Rotate Z Rotation on the z-axis. As rotate x and y. 
 
 
RLSurface2 
 
Shape Choose the shape you would like to display the video or image 

on. 
X   The x position of the shape 
Y  The y position of the shape 
Zoom  Defaults to 50%. 51 – 100% is zoom in and 0-49% is zoom out. 
Rotate X Rotation on the x-axis. 0 – 50% is position, 51-75% clockwise 

rotation and 76-100% anticlockwise rotation. 
Rotate Y Rotation on the y-axis. As rotate x. 
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Perspective Set the perspactive of the image. 
TL  Tweak the angle of the top left corner of the display 
TR  Tweak the angle of the top right corner of the display 
BL  Tweak the angle of the bottom left corner of the display 
BR  Tweak the angle of the bottom right corner of the display 
 
 

RS232 devices / RLSwitch 
 
The following is an example of an RS232 device. Please note that there are 
currently only a couple of RS232 fixtures in the RADlite software, but these 
can be added as and when needed. 
Output 1 Select which input to route to output 1. 
Output 2 Select which input to route to output 2. 
Output 3 Select which input to route to output 3. 
Output 4 Select which input to route to output 4. 
Output 5 Select which input to route to output 5. 
Output 6 Select which input to route to output 6. 
Output 7 Select which input to route to output 7. 
Output 8 Select which input to route to output 8. 
 

 

RLWave   (multi layer fixture) 
 
Level Adjusts the opacity of the wave form. 0% is fully transparent and 

100% is fully opaque. 
Mode Selects the wave form type to be displayed. There are currently 

4 types of wave form.  
Gain  Selects the volume level the wave is displayed at 
Detail  The level of detail displayed in the wave form 
Colour  Selects a palette from the palette library 
Red  Red component of the wave 
Green  Green component of the wave 
Blue  Blue component of the wave 
Speed  0 - 50% is the position of the cycle, 51-100% is the speed at 

which the palette cycles 
Rate   Select the refresh rate.  
X  The position of the wave on the x axis 
Y  The position of the wave on the y axis 
Zoom  Defaults to 50%. 51 - 100% is zoom in and 0-49% is zoom out. 
Rotate 0% is static, 0-49% are angles between 0 and 360°, 50-74% is 

clockwise rotation of varying speed and 75-100% is anti-
clockwise rotation of varying speed. 
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RLParticle  (multi layer fixture) 
 
Level Adjusts the opacity of the particle form. 0% is fully transparent 

and 100% is fully opaque. 
Age Determines the age of the oldest particle. At 100%, the particles 

will live for XXXXseconds. 
Weight Determines whether more or less gravity is present in the 

particles environment, causing an upward or downward flow. 
Speed The speed at which the individual particles are produced 
Size  Determines the size of the individual particles 
Image Draws the particles using images from the particle media list  
Colour Uses the colour palettes from the palettes media list. 
Red  Sets the red component of the particles 
Green  Sets the red component of the particles 
Blue  Sets the red component of the particles 
X  The X position of the starting point of the particles. 
Y  The Y position of the starting point of the particles 
X-Spread Allow the particles to be born along the x-axis 
Y-Spread Allow the particles to be born along the y-axis 
Rate  Determines the rate at which the particles are born 
Clump Determines how many particles are born at any one time. 
Direction Set the direction of particle flow 
Scatter Set the amount of divergence from the direction 
Path  Choose preset path directions such as circle and sine wave 
Zoom  Select the zoom ratio for the particles. 

Shutting down the RADlite 
To close the RADlite software choose the exit option from the file menu or 
click on the cross on the top right side as with other windows programs. 
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Chapter 

4 
The RADlite Control Panel: 
Menus 

The menu bar contains the set-up parameters of the RADlite system. 

The File Menu 
The File menu deals with creating, loading, saving and exiting shows. 
 

 

Creating a new show 
To create a new show, choose New from the File menu. 
The New Show window will open. Add a name and choose the fixtures you 
want to add to the show. The default fixtures are canvas, graphic and mask 
fixtures. Please note that the number of layers of graphics, mask and text are 
decided here although it is possible to add more to a show at a later date by 
pressing the + key in the plugins window. 
Graphics layers, masks and text etc can all be patched in any number of times 
and the lowest in the list will take precedence in the display. It is easy to show 
all these layers at the same time by turning down the level. 



 

Please remember that only one canvas layer per show can be used. This is 
an important point as if more than one is used, this will cause the RADlite 
system to run differently than you would normally expect. 
 

 
 

Opening a saved show 
Choose File,Open  to open a previously saved file. 
  

 

Saving a show 
Choose save if your show was already loaded up. If you created a new show, 
then choose the save as button 
 

Import and Export 
These menu items are currently inactive but will be implemented at a later 
date and will be available as a free software upgrade. 
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The Edit Menu 
The Edit menu is self-explanatory. Most options can also be accessed via 
buttons and icons within the Control Panel. 

 

The View Menu 
Choose which window to view. Again, buttons for these functions are available 
within the Control Panel. 

 
 

The Run Menu 
 

 
 

Show Video 
This option allows you to display the preview in a floating window or display 
the second output. It is important to check this if you appear to have no 
output. 
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Receive DMX 
This is a switchable function and should be ticked when the protocol has been 
set to a non-local one. 
 

Send DMX 
Another switchable function. To enable DMX output, please ensure this option 
is ticked. 
 

Reset 
Resets all local control faders to the defaults. 
 
 

The Configure Menu 

 
 

Audio 

DMX 

Library 

Video Input  

Output Size 

Performance 
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Video Output 
Choose the output display size. 
The video output deals with the size and placement of this window on the 
screen as well as the size and position of the main output display. 
 
 

This icon produces a floating preview window at 320 x 240. The floating 
window can be moved around by clicking on it and moving it around the 
desktop. 
 

This setting allows you to select custom size and position of the output 
window and preview monitor. 
 
 

 
Using the monitor 1 or 2 setting will make the RADlite output to either the 
monitor usually displaying the RADlite control software (monitor 1) or the 
second output device. ( The second output device can be a monitor, projector 
plasma screen etc). The settings for both monitor 1 and 2 are set using the 
Matrox settings in the control panel on the PC. 
 
To find out about resetting the Matrox displays for monitor 1 and 2, please 
consult the Matrox manual supplied along with your RADlite. There is also 
more information in this manual in Chapter 13. 

 

Video Input 
The video input section is concerned with any external device such as a 
camera, DVD player or video switch that you may wish to run through the 
RADlite. 
 
Choose from the list the format and resolution that you would like the RADlite 
to capture the frames. Select the Set Format button to see a list of options. 
Please note DVD quality is 768 x 576, 25 fps PAL, 30fps NTSC. 

24 



 

 
 

 

DMX 
This window controls the DMX protocol to be used and the number of output 
channels that are needed. Please note, the number of output channels in this 
section should equal the number of actual dmx lines that are being used. If 
you have a number in here that is higher than those lines being used, the 
RADlite system could encounter problems. 
 

 

 

Performance 
Configuring the performance allows you to optimise the system for your 
specific requirements 
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Give priority to 
This option allows the user to set the priority of the RADlite system. If it is 
mainly being used for full, high-resolution video, then position the slider to the 
right. For graphic use, slide to the left. If the RADlite system is being used 
equally for video and graphical output, the position the slider in the middle. 
 
Smooth Lines 
The Smooth Lines button can be clicked on or off. In its on position, it will anti-
alias graphics within the RLgraphics fixtures. 
 
Please note: When using the anti-alias feature, there will be an outline drawn 
around the image. This is only apparent when displaying graphics over video 
in RLcanvas. I.e. when the video mode is set to Mode 11. If using this mode, 
we recommend that the Smooth Lines button is in the off position. 
 
Fader Sensitivity 
Set the on/off land maximum levels of lighting desk faders. This is a useful 
feature if the desk has sticky faders or there is any vibration affecting the 
desk. 
 
Use Quicktime if available 
In this version, Quicktime and Java Media Framework are both used with the 
RADlite system. The default is JMF. 
This option sets the system to automatically use Quicktime instead of Java 
Media Framework. Using Quicktime has advantages and disadvantages. 
Advantages: 

• More file formats are accepted 
• Less chance of any video corruption occurring 

Disadvantages 
• Video Input is disabled 
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Please note. The next release of RADlite will not use JMF and the video input 
will be supported with Quicktime. 

Library 
The library is the central repository for any media which RADlite uses, such as 
images, video files, messages etc. RADlite is not able to make use of any files 
which are outside the library therefore it is important that any files which you 
wish to use are placed in here prior to them being displayed. 
To configure the library location, simply select the directory in windows where 
it is stored. 
 
 

The Help Menu 

Registration 
If you are running an evaluation version and then decide to purchase the full 
system, this menu gives you the machine ID number which will need to be 
sent to IRAD. You will then be sent a serial number that will need to be typed 
into the serial number field. 
Once this number has been entered, close down the program and restart it. 
Check that the words evaluation version no longer appear in the uppermost 
bar of the control panel. 
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5 

 

 
 

The RADlite Control Panel : 
The Patch Window 

The Patch Window is responsible for defining what Fixtures 
are to be used for the show. The local control faders are also 
found in this window and can be used if Local Control is 
selected from the protocol list in the Configure DMX dialog 
box.. 

 
 



 

 
The Patch window is activated when the RADlite program is opened.  To 
select the Patch Window from any other position, choose either the Patch 
option in the View menu, or click on the Patch button on the top left hand side 
of the Control Panel. The Patch window offers two ways of monitoring your 
output. Either view the DMX values of each fixture within the DMX window, or 
view a preview of the output in the Monitor window. There are two different 
views of the Patch window, outlined below. 

The DMX window 
Select this using the DMX tab on the left of the fixture list in the patch window 
or by selecting DMX from the View menu. 
 

 

The Monitor window 
Select this using the monitor tab on the left of the fixture list in the patch 
window. 
The preview monitor is mainly for use with PixelDrive. The output of 
RLSurface and RLCanvas are not currently displayed here. All other fixture’s 
output can be viewed normally even when another video output is selected. 
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There are three different views in the monitor window: 

• Video shows a preview of the full output of RLGraphic, RLMask, 
RLText,and RLWave 

 

 
 
 
• Matrix shows the preview of the output as above transposed onto the 

pixel matrix that has been constructed. 
 

 
 
 

• Grid displays the actual matrix array . 
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6 
The RADlite Control Panel : 
The Media Window 
Select either the Media option in the View menu or click on the Media button 
at the top of the Control Panel. 
This window allows you to add, delete or change the order of media in your 
RADlite show. 
 
 

 
 
 
 
 



 

Types of media 
 
A RADlite show contains five lists of media, these are: 

• Videos 
• Graphics 
• Palettes 
• Shapes 
• Text 
• Particles 

Each of these lists may contain between 1 and 256 items. These are the 
RADlite’s equivalent of gobo wheels and are shared between all of the fixtures 
that are patched into a show. 
It is possible to set a definite number of media files per list in the configure 
library dialog box, setting any slots not yet filled to a blank, white rectangle. 
This will enable you to add further media files even after you have begun 
programming from your dmx controller. 
 
The Media window allows the user to see and modify the contents of these 
lists. Here is a typical example: 
 

 
 
Images 
RADlite can make use of various formats, GIF, JPEG, TIF, BMP and PSD. All 
of these image types can either be stored as full colour (256 colour in the case 
of GIF) or they can be forced into greyscale images.  These greyscale images 
produce the most interesting effects as RADlite provides a comprehensive set 
of real time colour control functions, which are not available to full colour 
images. 
Images can be any reasonable dimension but it is important to note that all 
images in a show are loaded into memory when the show is opened. A large 
number of large images could conceivably consume all the memory resources 
available to RADlite so keep to the following guidelines if possible: 
Always store images at 72dpi – this is what they will be displayed at so there 
is no point in using a higher resolution 
Try to keep the image no bigger than twice the size of the graphics output 
window – images can only be scaled to twice their normal size so any bigger 
is a waste. 
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Never save JPEG images as progressive or GIF’s as interlaced. 
Although these methods are ideal for web graphics, they will not work 
with the RADlite system. 
 
Low-resolution video clips can be imported into the image library and 
therefore used on the graphic layers. We recommend QuickTime movies at 
320 x 240, using photo jpeg or cinepak compression. These files will run 
alongside other graphic layers, but as with images, the files will be loaded into 
memory when the show is opened, and could also affect memory 
consumption. 
 
Palettes 
Palettes can be applied to GIF images to provide a range of colourisation and 
cycling effects. RADlite accepts the following file format for palettes: 
 
 
File type Description 
PAL Standard windows palette files in JASC format. These can be created 

with image editing programs such as Paint Shop pro or PhotoShop. 
JPG/GIF RADlite can create a palette by extracting the colours from an image. 

It does this by reading the colours of the first 256 pixels in the first line 
of an image. 

SWT This is a proprietary file format used by RADlite for palette files 
 
Shapes 
Shapes are vector files that describe an outline. They are used to define the 
boundaries in which an image can be drawn, and also to provide masks that 
restrict the amount of the image that is visible. 
Currently, there is a portion of the Beacon Gobo Library included with your 
RADlite system. Should a more bespoke shape be needed, then simply 
contact IRAD for advice on how to create new shapes. You will probably find 
that IRAD can do them for you! 
 
Video 
RADlite can play video files from the hard disk and also display and process a 
live camera feed. Both video files and the live feed can be up to full DV 
resolution (768x576) at 25 frames per second (PAL) or 30 frames per second 
(NTSC). 
 
Video files can be stored as AVI or QuickTime format and a variety of the 
common video Codecs are supported, namely: 
Motion JPEG / Photo JPEG 
Cinepak 
Indeo 5.1 
 
In addition, RADlite is able to make use of any standard Windows Codecs 
provided that they: 

• Are Windows VCM compatible 
• Support 24 and/or 32 bit colour. 
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This makes it possible to use third party video codecs such as DiVx and 
MPEG4. 
 
Please Note: Videos containing an audio track will cause the RADlite 
problems, so please ensure the video file has no audio track. 
 
It is also useful to note that often, videos created or compressed using 
Apple Mac systems often compress the header of the file. The RADlite 
system does not read these compressed headers and as such, they 
should be removed using any video-editing program. 
 
Messages 
Short pieces of text can be displayed and manipulated by RADlite. These are 
slightly different to other library elements in that they are not stored as 
individual files but are entered directly into the RADlite control panel and 
stored as part of the show file. 
 
Particles 
The particle library list can contain any image that may be present in the 
image list. It is worth noting that low-resolution images can be used with 
particles as they produce an abstract, organic display and are necessarily not 
reliant on crisp imagery. 

Adding media to the show 
 
Adding any media to your RADlite show could not be easier. Select the 
appropriate tab on the left hand side of the window to add either images, 
palettes, video, shapes or text. With all media except text, as long as the files 
have been put into the correct Windows directory, they can be added by 
pressing the + button. This will bring up a window with a directory structure on 
the left hand side and a preview of the file on the right side.  
Please note that more than one image/shape/video/palette can be selected at 
any one time. Click on one after the other to add to the list. If you make a 
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mistake, simply click on the preview again to remove it from the list. The items 
will be added to the Media Window once OK has been pressed. 

Images 
 
When adding images to your show, please take note of the following options 
and their effects upon the final output. 

Selecting the image in the media list and then clicking on this button makes 
the image lose its original colour and replaces them with a 256 level greyscale 
image. These images will then work in conjunction with the colour palette and 
cycling effects. 
 

This button allows the original image colours to be displayed. Please note that 
some of the colour effects in RLgraphics will not be usable if this option is 
chosen. 
 

Pressing this button will allow you to select one colour from within a greyscale 
image to class as transparent. This will mean that those areas will be 
transparent in the output display, allowing for different effects between layers. 
As a default, all JPEG images will be displayed as full colour and Gif images 
as greyscale. 
 
 
 

 
Above: right A gif image in full colour and left in greyscale 

Palettes  
Palettes are added as any other media and have no separate parameters to 
play with. 
 

Shapes 
Again simply selecting the shapes needed from the directory will them to the 
media list. 
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Video 
Adding video from the directory into the RADlite show is also simply a matter 
of selecting the + button and finding the appropriate files for the show. 
Please note that as the video clips can be previewed within the Media 
Window. Click on the > button on the bottom left of the preview window. 

 

 

 

 

 

Text 
Adding text messages to the media window is slightly different. 
 

 
After pressing the + in the text section, the above window will appear. 
Type into the window the message that you wish to use. Within this window, 
there is the ability to change the font, size and emphasis of the text. You can 
also decide whether it should be aligned to the left, right or centrally and 
choose whether or not to wrap the text from one line to the next. 
Up to 256 messages can be created for any one show. 
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Particles 
Adding particles is the same as adding other media, simply select the files you 
want and click ok. 
 

Removing media from the show file 
Simply select the item on the list in the Media window that you wish to remove 
and click on the – button to remove it from the show. This will not delete the 
file from the hard drive; just remove it from the current show. 
 

Changing the order of media 
To move images/palettes/shapes/videos around in the list, simply select one 
and, using the arrow buttons, move it up or down the list. This will change the 
order it is displayed in the image parameter, for example. 
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Creating a RADlite Show 

A RADlite show is a combination of the Fixtures chosen (See 
Chapter 3) and the Media selected. 

Creating a new show 
To create a new show, choose New from the File Menu. 
The New Show window will open. Add a name and choose the fixtures you 
want to add to the show. The default fixtures are canvas, graphic and mask 
fixtures. Please note that the number of layers of graphics, mask and text are 
decided here although it is possible to add more to a show at a later date by 
pressing the + key in the plugins window. 
Graphics layers, masks and text can all be patched in any number of times 
and the lowest in the list will take precedence in the display. It is easy to show 
all these layers at the same time by turning down the level. 
Please remember that only one canvas layer per show can be used. This is 
an important point as if more than one is used, this will cause the RADlite 
system to run differently than you would normally expect. 

 



 

 

Opening a saved show 
From the Disk Window, choose open and select the relevant file from the list. 
  

 

Saving a show 
From the Disk window, choose save if your show was already loaded up. If 
you created a new show, then choose the save as button. 
 
 

 
 

Library Location 
By selecting Configure Library, you can change the directory that the Media 
Window looks at when adding new media. The default setting is C:Program 
files/radical lighting/Radlite43/lib. We recommend that you store all you media 
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files in sub-directories of this library directory to avoid losing any files from the 
show. 

Adding a new fixture 
From the patch window, choose the + key. This will enable you to add RADlite 
fixtures to your existing show. Remember that they will automatically be 
placed below the fixture that is highlighted when the + button is pressed. 
Refer to the section on changing the order of processing below to alter this. 
 

 

 

Removing a fixture 
Again, in the patch window, select the fixture you wish to remove. Press the – 
key to remove it. The list will automatically reshuffle itself so that there is not a 
gap where the fixture previously was. 

Addressing fixtures 
The RADlite system will automatically address each fixture. This number will 
be shown in the patch window next to the fixture name in brackets. 
Selecting the fixture in the list and manually entering a number in the address 
field can change this number. This will automatically update the patch table on 
in the DMX window. 
Please note, the program will not correct if addresses overlap. 

Changing the order of processing 
If you find that the fixtures you have patched into the RADlite are in the wrong 
order for your needs, then it is simple to change. Remember that the further 
down the list the fixture is, the higher up in the display it is. I.e. last takes 
precedence. 
To change the order, first select the fixture that needs to be moved in the 
patch window. Next, change its position in the list by using the up and down 
arrows. This will take effect immediately. 
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Local Control 

Selecting the fixture to control 
Choose the fixture from the patched in fixtures by selecting it from the fixture 
list on the left hand side of the control panel. 
As each is selected, the controls on the right hand window, either underneath 
the dmx values or the preview monitor will change to display the relevant 
parameters for the fixture. For example, if RLCanvas is selected, the 
parameters shown will include trail, mode etc. If a graphic is selected, then 
image, shape etc parameters will be displayed. 
 

Using the faders 
To change the parameter values, use the mouse to grab the sliders on each 
fader. Click on the mouse button, move the slider to where you want it to go 
whilst still pressing. When the slider is in position, release the mouse button. 
The window normally fits 10 faders; use the horizontal window scroller to see 
more faders. 
 

Reset  
Pressing the reset button in the Run Menu will reset all parameters to the 
default settings. 
 
 

DMX Control 

Patching in RADlite Fixtures 
Each Lighting desk is different. Most well known desks will already have 
personalities for all the RADlite fixtures. These are also stored in the R4Lib 
directory, under Personalities. 
Ensure that when patching in the fixtures into the desk, they are given the 
same address as in the RADlite software. 
If you cannot find the personality / profile for any RADlite fixture, please 
contact IRAD. 
All the RADlite parameters are made to behave as much like a moving light as 
possible so that operation from a lighting desk is very intuitive. 

Recv 
The Recv icon flashes green to show that a DMX signal is being received 
when using any of the DMX protocols.  
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Using PixelDrive  

PixelDrive is a way of creating complex patterns for the James 
Thomas Pixel Range.  

Adding and removing Pixel Range Fixtures 
In the Patch Window, select Matrix Devices on the left hand side of the 
Control panel. 
Use the + button to add a fixture. The following window will appear: 
 

 
 
 
Choose whether the Pixellines are to be placed horizontally or vertically by 
choosing the V or H button in the Orientation field. 
 
Pixel Size and Gap are concerned with how much detail of the RADlite output 
is to be displayed on each LED cell. The Pixel Size is based on the preview 



 

monitor. If the size is set to 10 x 10, then PixelDrive will divide the monitor into 
cells 10 pixels by 10 pixels. It will then select the centre pixel of this cell. This 
pixel value will then be displayed on one Pixelline cell. The Gap value should 
correspond with any physical space between pixellines. The value here is in 
pixels. 
 
If there are multiple pixellines placed in the same orientation, then put the 
number of rows and columns in the appropriate fields and the PixelDrive 
control will add the correct number of battens to the preview. If the battens are 
of a more complex arrangement, then they will need to be placed individually 
and the Row and Column values should be left at 1. 
 
Assign the first DMX address (usually universe or line 1 and address 1). If 
you have added multiple battens by using the row and column field, each 
Pixelline will be addressed accordingly. These values can be adjusted from 
the Patch Window if necessary. 
Again, if adding the pixellines one at a time, then you will need to type in the 
value needed for each in this field. 
 
The Pixelline 1044’s contain 18 LED cells each. This is the standard and each 
cell has 3 channels; Red Green and Blue. This means that each batten will 
require 54 channels. There are also 7 channels which refer top the pixelline’s 
internal chases. These are accessed via the PixelDrive fixture. 
The Pixelline fixtures should always be set to Max 1 mode. 
 
 
To remove a fixture, simply select it from the list and hit the – button at the top 
of the list. 
 

Configuring the Display 
To configure the matrix display, ensure that you have selected Grid in the 
Monitor Window. Select individual fixtures by selecting them in the list on the 
left, or select a range by using the shift key and selecting the fixtures in the 
same list. 
The selected fixtures can then be moved around the preview monitor using 
either the Nudge buttons or by actually typing in the x and y position. 
If more dmx fixtures are added at a later time, Send Dmx in the Run Menu 
must be toggled in order for the output to be mapped onto the new areas. 
 

Operating the PixelDrive system  
Ensure that the fixtures have been addressed correctly, i.e. so that the 
address within RADlite and the physical address on the fixture itself are the 
same and that the fixtures are set to MAX 1 mode. 
 
Once the matrix has been correctly formatted and positioned, the system is 
ready to be used.  
In the Monitor Window, decide whether to view the preview as full video or as 
the matrix output.  
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RLCanvas and RLSurface cannot be used to output onto the matrix. Using 
only the PixelDrive, RLGraphics, RLText, and RLWave fixtures, create a 
RADlite show as usual. Please note; output from the PixelDrive RADlite fixture 
will not be displayed in the preview monitor. 
 
The PixelDrive system is operated exactly as a RADlite show. The main 
difference is that the output is via DMX rather than video. 
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Optimising the graphics and 
video output 

Selecting which display output to use 
The display output device is the actual device that you wish to use to display 
the RADlite’s output. The RADlite system has a dual head display system. 
These displays, called monitor 1 and monitor 2, are set up using the Matrox 
display properties in the control panel. 
 

 
From the control panel (or by right clicking anywhere on the desktop and 
choosing properties) choose the display settings as above. 



 

Please note that monitor 1 is the only display that can output in 16:9 ratio, i.e. 
widescreen. However, there is no composite or s-video output from monitor 1 
only VGA, so a scan converter would be necessary to output video display. If 
this is needed then use the display window above to swap display output so 
that monitor 2 becomes the output device displaying the control panel.  
For ordinary 4:3 output such as 640 x 480, 800 x 600 etc, we recommend that 
you use monitor 2 as it can output a composite or S-video signal which are the 
most reliable and stable output signals. 

 

Choosing the best display size 
Deciding what size to best display the output can be tricky. 
Shapes and images are easy to resize, so it is best to stick to 640 x 480 or 
800 x 600 for these. 
Video display is also affected by resizing. If the input is 320 x 240 as in an 
MPEG1 format and the display properties are set to 640 x 480, the video will 
have to be resized. Some quality can be lost if this is the case. 
When using broadcast quality video, the input resolution will be 768 x 576. If 
the output resolution is less than this, the RADlite system may have problems 
down sizing a large file. It is best to set the Matrox properties output to 800 x 
600 in this case and follow the advice below. 
  

Tweaking the video output 
If your video input is 768 x 576, then set the monitor display size to 800 x 600. 
and then tweak the settings in the display properties within the Matrox Power 
Desk control panel. This will stop the black border around the display as the 
output will be trying to display the output in a 4:3 ratio, or 800 x 600. 
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Advanced Settings 
From the settings window in the Matrox display properties, choose the 
advanced button. 
In order for the RADlite system to work correctly, the Hardware acceleration 
should be set to None  or a maximum of 1on both monitor 1 and 2. However, 
if you need to tweak any settings as in the last section, the acceleration must 
be switched on.  
After adjustments have been made, the acceleration should be set back to 1 
in order for the system to function correctly and store the adjustments made. 
The Power Desk tab will be greyed out when acceleration is set to none. 
 

 

Other Matrox adjustments 
There are several other adjustments that can be made to the RADlite output 
display using the Matrox properties window. For a fuller explanation, please 
see the Matrox manual supplied with your RADlite.  
Below are some screenshots of other useful Matrox settings. 
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Troubleshooting 
 

Reporting errors  
In the event of the RADlite system not working properly, it is easy to check 
whether an error has occurred. Close the RADlite program and open up the 
directory called R4 on the hard drive. Within this directory, there should be a 
file called Rlerror.txt. This file should be mailed directly to the IRAD technical 
team who can analyse it and send out a fix as soon as possible if necessary. 
         

Adding patches and upgrades 
Adding patches and upgrades is simple with the RADlite software. First, 
shutdown the RADlite program by using the shutdown button in the system 
window. This allows you to access Microsoft Windows. 
Find the directory R4x. The following files are essential to the RADlite 
program: R4x.jar, jbcl3.0.jar, RADgl.dll, RADjpg.gll, Qtjava.zip and 
radlite.bat. Usually with an upgrade, the .jar and .dll files will be overwritten.  
Patches and upgrades will normally be e-mailed to you, providing you have 
the subscription, although they will also be available on the website. Please 
note that the existing files should be renamed with an extension of .old just in 
case there are any problems with the upgrade. 

 

Who to contact 
For serious operation errors, IRAD are always happy to help out. Please e-
mail error log files to: quinch@info-rad.demon.co.uk and  telephone Simon 
Carter on +44 (0) 7970 069223 or +44 (0)1274 841414.  
Use the last number also if further training is required or if an operational 
question arises that is not fully covered in this manual. 
For non-serious errors and requests for upgrades, please contact the place 
that the RADlite was purchased. 
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Channel Assignments 

Please note all channels highlighted in Green are 16-bit.  All 
other channels are 8-bit. 

RLCanvas 
12 channels 
 
 

Attribute 

 

Default 
% 

 

Description 

 

Hog 
Bank 

 

Avolites 
Bank 

 
Level 

 
100 

Adjusts the brightness of the video layer. If 
this is below 2% and a video is selected 
then the video is paused, raising it above 
2% will resume playing of the video 

 
I 

 
Dimmer

 
Wipe 

 
0 

Currently there are three transitions that 
can be used between video clips. The first 
is a wipe from the left, the second a wipe 
from the right and the third a basic 
dissolve. 0 is no transition. 

 
B 

Shutter 

 
Wipe 
speed 

 
50 

This parameter controls the speed of the 
wipe with 0 being off and 100 being the 
fastest speed. 

 
B 

Shutter 

 
 

Trail 

 
 

0 

The trail parameter is the effect of any 
moving part of the display leaving a 
shadow, or trail behind. This controls the 
length of time the trail is visible. 100% is 
constant, 0 is off. 

 
B 

Colour 

 
 

Mode* 

 
 

0 

When video is playing, there are several 
modes which it can interact with other 
layers in the display. This parameter 
controls which of these modes is used. The 
default value is 0% which is no effect. 

 
 
C 

Colour 

  This parameter chooses which video to  Gobo 

Appendix 

A 



 

Source/ 
video 

0 play from the library in the RADlite system. 
Up to 255 video clips can be stored in any 
one video library. 0 is no video. 

B 

 
Speed 

 
100 

Again, concerning video; this parameter 
allows control of  video playback speed. 
100% is normal, 0 is stop 

 
B 

Speed 

Position 0 This allows the user to choose the video 
frame and shuttle between different frames 
of the playing video. 

F Effect 

Red 100 The red component of the canvas layer. 
100% is full red, 0% is no red. 

C Yellow 

Green 100 The green component of the canvas layer. 
As above, but green. 

C Cyan 

Blue 100 The blue component of the canvas layer. 
As above, but blue. 

C Magent
a 

* see chapter 3 for full breakdown of video modes. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

52 



 

RLGraphics 
23 channels 
 

 

Attribute 

 

Default 
% 

 

Description 

 

Hog 
Bank 

 

Avolites 
Bank 

 
 

Level 

 
 

0 

The brightness control. It will default to 0 
%, which means it is off. Remember to 
increase this level to be able to see the 
output. If this level is toggled somewhere 
between 0 and 100, the layer beneath will 
become more or less visible. 

 
 
I 

Dimmer

 
 

Image 

 
 

0 

Selects the images that you have imported 
into the RADlite show. The first image in 
the library will be given the value 1% and 
the last is 100%. 0% is no image. 

 
 
B 

Gobo 

 
 
 

Shape 

 
 
 

0 

This contains the all the shapes you have 
imported into the current show. It 
determines the shape the image is drawn 
into. No shape is 0% 

 
 
 
B 

Gobo 

 
Width 

 
0 

This is the option to draw the image or 
colour fill rather than fill it. 0% is filled, 1 - 
100% are the actual pixel width of the line 

 
B 

Iris 

X 50 The position of the image and/or shape on 
the x axis. 0% is the furthest left position 
and 100% the furthest right. 

F Pan 

Y 50 The position of the image and/or shape on 
the y axis. 0% is the furthest up position 
and 100% the furthest down. 

F Tilt 

Zoom 50 Defaults to 50%. 51 - 100% is zoom in to 0 
and 0-49% is zoom out to 2x. 

B Zoom 

Aspect 50 Also defaults to 50 which is static. 0-49% is 
the horizontal aspect and 51-100% is the 
vertical aspect 

 
B 

Zoom 

 
 

Rotation 

 
 

0 

 
0% is static, 0-49% are angles between 0 
and 360°, 50-74% is clockwise rotation of 
varying speed and 75-100% is anti-
clockwise rotation of varying speed. 

 
 
B 

 
 
Rotation 

Red1 100 The Red component of the first colour of a 
gradation. 100% is full red. 

C Yellow 

Green1 100 The Green component of the first colour of 
a gradation. 100% is full green. 

C Cyan 

Blue1 100 The Blue component of the first colour of a 
gradation. 100% is full blue. 

C Magenta

Red2 0 The Red component of the second colour 
of a gradation. 100% is full red. 

C Shift 
Yellow 

Green2 0 The Green component of the second C Shift 
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colour of a gradation. 100% is full green. Cyan 
Blue2 0 The Blue component of the second colour 

of a gradation. 100% is full blue. 
C Shift 

Magenta
Colour 0 The choice of colour palettes from the 

palette library. 0% is no palette selected. 
C Colour 

 
Div 

 
0 

The frequency of the gradation. I.e. blue to 
red, or blue to red to blue to red to blue to 
red etc. 0% is once only. 

 
C 

 
Colour 

 
Speed 

 
0 

The speed at which the palette cycles 
between its individual colours. 0% is static, 
100% is the fastest cycling speed. 

 
B 

 
Speed 

Fx 0 Select effects mode B Shift 
Effect 

Fx 
Depth 

0 Prism depth, i.e. distance between facets. B Effect 

Fx Size 0 The number of facets used in a prism. B Shift 
Speed 

Fx 
Speed 

0 To be implemented at a later date. B Rotation 
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RLGraphics16 
26 channels 
 

 

Attribute 

 

Default 
% 

 

Description 

 

Hog 
Bank 

 

Avolites 
Bank 

 
 

Level 

 
 

0 

The brightness control. It will default to 0 
%, which means it is off. Remember to 
increase this level to be able to see the 
output. If this level is toggled somewhere 
between 0 and 100, the layer beneath will 
become more or less visible. 

 
 
I 

Dimmer

 
 

Image 

 
 

0 

Selects the images that you have imported 
into the RADlite show. The first image in 
the library will be given the value 1% and 
the last is 100%. 0% is no image. 

 
 
B 

Gobo 

 
 
 

Shape 

 
 
 

0 

This contains the all the shapes you have 
imported into the current show. It 
determines the shape the image is drawn 
into. No shape is 0% 

 
 
 
B 

Gobo 

 
Width 

 
0 

This is the option to draw the image or 
colour fill rather than fill it. 0% is filled, 1 - 
100% are the actual pixel width of the line 

 
B 

Iris 

X 50 The position of the image and/or shape on 
the x axis. 0% is the furthest left position 
and 100% the furthest right. 

F Pan 

Y 50 The position of the image and/or shape on 
the y axis. 0% is the furthest up position 
and 100% the furthest down. 

F Tilt 

Zoom 50 Defaults to 50%. 51 - 100% is zoom in to 0 
and 0-49% is zoom out to 2x. 

B Zoom 

Aspect 50 Also defaults to 50 which is static. 0-49% is 
the horizontal aspect and 51-100% is the 
vertical aspect 

 
B 

Zoom 

 
 

Rotation 

 
 

0 

 
0% is static, 0-49% are angles between 0 
and 360°, 50-74% is clockwise rotation of 
varying speed and 75-100% is anti-
clockwise rotation of varying speed. 

 
 
B 

 
 
Rotation 

Red1 100 The Red component of the first colour of a 
gradation. 100% is full red. 

C Yellow 

Green1 100 The Green component of the first colour of 
a gradation. 100% is full green. 

C Cyan 

Blue1 100 The Blue component of the first colour of a 
gradation. 100% is full blue. 

C Magenta

Red2 0 The Red component of the second colour 
of a gradation. 100% is full red. 

C Shift 
Yellow 

Green2 0 The Green component of the second C Shift 
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colour of a gradation. 100% is full green. Cyan 
Blue2 0 The Blue component of the second colour 

of a gradation. 100% is full blue. 
C Shift 

Magenta
Colour 0 The choice of colour palettes from the 

palette library. 0% is no palette selected. 
C Colour 

 
Div 

 
0 

The frequency of the gradation. I.e. blue to 
red, or blue to red to blue to red to blue to 
red etc. 0% is once only. 

 
C 

 
Colour 

 
Speed 

 
0 

The speed at which the palette cycles 
between its individual colours. 0% is static, 
100% is the fastest cycling speed. 

 
B 

 
Speed 

Fx 0 Select effects mode B Shift 
Effect 

Fx 
Depth 

0 Prism depth, i.e. distance between facets. B Effect 

Fx Size 0 The number of facets used in a prism. B Shift 
Speed 

Fx 
Speed 

0 To be implemented at a later date. B Rotation 
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RLMask 
11 channels 
 

 

Attribute 

 

Default 
% 

 

Description 

 

Hog 
Bank 

 

Avolites 
Bank 

Level 100 Adjusts the opacity of the mask. 0% is fully 
transparent and 100% is fully opaque. 

I Dimmer

Mask 0 Picks a mask shape from the shape library. B Gobo 
X 50 Choose the x position of the mask. F Pan 
Y 50 Choose the y position of the mask. F Tilt 

Zoom 50 As in RLgraphic. B Zoom 
Aspect 50 As in RLgraphic. B Zoom 

Rotation 0 As in RLgraphic. B Rotation 
Red 0 The Red component of the mask 

background. 
C Yellow 

Green 0 The Green component of the mask 
background 

C Cyan 

Blue 0 The Blue component of the mask 
background 

C Magenta
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RLMask16 
14 channels 
 

 

Attribute 

 

Default 
% 

 

Description 

 

Hog 
Bank 

 

Avolites 
Bank 

Level 100 Adjusts the opacity of the mask. 0% is fully 
transparent and 100% is fully opaque. 

I Dimmer

Mask 0 Picks a mask shape from the shape library. B Gobo 
X 50 Choose the x position of the mask. F Pan 
Y 50 Choose the y position of the mask. F Tilt 

Zoom 50 As in RLgraphic. B Zoom 
Aspect 50 As in RLgraphic. B Zoom 

Rotation 0 As in RLgraphic. B Rotation 
Red 0 The Red component of the mask 

background. 
C Yellow 

Green 0 The Green component of the mask 
background 

C Cyan 

Blue 0 The Blue component of the mask 
background 

C Magenta
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RLText 
12 channels 
 
 

Attribute 

 

Default 
% 

 

Description 

 

Hog 
Bank 

 

Avolites 
Bank 

Level 100 Adjusts the brightness of the text. 0% is off. I Dimmer
Text 0 Selects the text message from the text 

media in the show. 0% is no message. 
B Gobo 

Shadow 0 Variable size drop-shadow at various 
angles. 

B Effect 

X 50 The x-position of the text. As with 
RLgraphic 

F Pan 

Y 50 The y-position of the text. As with 
RLgraphic 

F Tilt 

Zoom 50 Zoom ratio of the text. As with RLgraphic B Zoom 
Aspect 50 Aspect ratio of text. As with RLgraphic B Zoom 

Rotation 0 Rotation of text. As with RLgraphic B Rotation 

Red 100 Red component of text colour. C Yellow 
Green 100 Green component of text colour. C Cyan 
Blue 100 Blue component of text colour. C Magenta 
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RLText16 
15 channels 
 
 

Attribute 

 

Default 
% 

 

Description 

 

Hog 
Bank 

 

Avolites 
Bank 

Level 100 Adjusts the brightness of the text. 0% is off. I Dimmer
Text 0 Selects the text message from the text 

media in the show. 0% is no message. 
B Gobo 

Shadow 0 Variable size drop-shadow at various 
angles. 

B Effect 

X 50 The x-position of the text. As with 
RLgraphic 

F Pan 

Y 50 The y-position of the text. As with 
RLgraphic 

F Tilt 

Zoom 50 Zoom ratio of the text. As with RLgraphic B Zoom 
Aspect 50 Aspect ratio of text. As with RLgraphic B Zoom 

Rotation 0 Rotation of text. As with RLgraphic B Rotation 

Red 100 Red component of text colour. C Yellow 
Green 100 Green component of text colour. C Cyan 
Blue 100 Blue component of text colour. C Magenta 
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RLSurface 
11 channels 
 
 

Attribute 

 

Default 
% 

 

Description 

 

Hog 
Bank 

 

Avolites 
Bank 

Shape 0 Choose the shape you would like to display 
the video or image on. 

B Gobo 

X 50 The x position of the shape F Pan 
Y 50 The y position of the shape F Tilt 

Zoom 0 Defaults to 50%. 51 - 100% is zoom in and 
0-49% is zoom out. 

B Shift 
Pan 

X-Rotate 0 Rotation on the x-axis. 0 - 50% is position, 
51-75% clockwise rotation and 76-100% 
anticlockwise rotation. 

 
B 

 
Rotation 

 
Y-Rotate 0 Rotation on the y-axis. As rotate x. B Rotation 

Z-Rotate 0 Rotation on the z-axis. As rotate x and y. B Shift 
Rotation 

Perspec-
tive 

0 Change the perspective of the Surface to 
enable keystoning etc. 

B Focus 
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RLSurface2 
15 channels 
 
 

Attribute 

 

Default 
% 

 

Description 

 

Hog 
Bank 

 

Avolites 
Bank 

Shape 0 Choose the shape you would like to display 
the video or image on. 

B Gobo 

X 50 The x position of the shape F Pan 
Y 50 The y position of the shape F Tilt 

Zoom 0 Defaults to 50%. 51 - 100% is zoom in and 
0-49% is zoom out. 

B Shift 
Pan 

X-Rotate 0 Rotation on the x-axis. 0 - 50% is position, 
51-75% clockwise rotation and 76-100% 
anticlockwise rotation. 

 
B 

 
Rotation 

 
Y-Rotate 0 Rotation on the y-axis. As rotate x. B Rotation 

Z-Rotate 0 Rotation on the z-axis. As rotate x and y. B Shift 
Rotation 

Perspec-
tive 

0 Change the perspective of the Surface to 
enable keystoning etc. 

B Focus 

TL 50 Advanced Keystoning. Top Left channel. 
0 - 49% moves corner outwards. 51-100% 
moves corner inwards 

  

TR 50 Top Right channel. 
0 - 49% moves corner outwards. 51-100% 
moves corner inwards 

  

BL 50 Bottom Left channel. 
0 - 49% moves corner outwards. 51-100% 
moves corner inwards 

  

BR 50 Bottom Right channel. 
0 - 49% moves corner outwards. 51-100% 
moves corner inwards 
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RLWave 
15 channels 

 

Attribute 

 

Default % 

 

Description 

 

Hog 
Bank 

 

Avolites 
Bank 

 
 

Level 
 
 

 
 

0 

The brightness control. It will default to 0 
%, which means it is off. Increase this level 
to be able to see the output. If this level is 
toggled somewhere between 0 and 100, 
the layer beneath will become more or less 
visible. 100% is fully on. 

 
 
I 

 
 
Dimmer

Mode 0 Select the wave form type to be displayed B Gobo 
Gain 50 Select the volume level the wave is 

displayed at 
B Shutter 

Detail 100 The level of detail displayed in the wave 
form 

B Shutter 

Colour 0 Selects a palette from the palette library C Colour 
Red 100 Red component of the wave C  

Green 100 Green component of the wave C  
Blue 100 Blue component of the wave C  

 
Speed 

0 0 - 50% is the position of the cycle, 51-
100% is the speed at which the palette 
cycles 

B  
Speed 

Rate 100 Select the refresh rate. B Speed 
X 50 The position of the wave on the x axis F Pan 
Y 50 The position of the wave on the y axis F Tilt 

Zoom 50 Defaults to 50%. 51 - 100% is zoom in and 
0-49% is zoom out. 

F Zoom 

Rotation 
 

0 0% is static, 0-49% are angles between 0 
and 360°, 50-74% is clockwise rotation of 
varying speed and 75-100% is anti-
clockwise rotation of varying speed. 

B Rotate 
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RLWave16 
18 channels 

 

Attribute 

 

Default % 

 

Description 

 

Hog 
Bank 

 

Avolites 
Bank 

 
 

Level 
 
 

 
 

0 

The brightness control. It will default to 0 
%, which means it is off. Increase this level 
to be able to see the output. If this level is 
toggled somewhere between 0 and 100, 
the layer beneath will become more or less 
visible. 100% is fully on. 

 
 
I 

 
 
Dimmer

Mode 0 Select the wave form type to be displayed B Gobo 
Gain 50 Select the volume level the wave is 

displayed at 
B Shutter 

Detail 100 The level of detail displayed in the wave 
form 

B Shutter 

Colour 0 Selects a palette from the palette library C Colour 
Red 100 Red component of the wave C  

Green 100 Green component of the wave C  
Blue 100 Blue component of the wave C  

 
Speed 

0 0 - 50% is the position of the cycle, 51-
100% is the speed at which the palette 
cycles 

B  
Speed 

Rate 100 Select the refresh rate. B Speed 
X 50 The position of the wave on the x axis F Pan 
Y 50 The position of the wave on the y axis F Tilt 

Zoom 50 Defaults to 50%. 51 - 100% is zoom in and 
0-49% is zoom out. 

F Zoom 

Rotation 
 

0 0% is static, 0-49% are angles between 0 
and 360°, 50-74% is clockwise rotation of 
varying speed and 75-100% is anti-
clockwise rotation of varying speed. 

B Rotate 
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RS232 Devices 
Varying channels 
 
The following is an example of an RS232 device. (Kramer 8 x 8 video matrix) 
Please note that there are currently only a couple of RS232 fixtures in the 
RADlite software, but these can be added as and when needed.  
 
 

Attribute 

 

Description 

Hog 
Bank 

Avolites 
Bank 

Output 1 Select which input to route to output 1.   
Output 2 Select which input to route to output 2.   
Output 3 Select which input to route to output 3.   
Output 4 Select which input to route to output 4.   
Output 5 Select which input to route to output 5.   
Output 6 Select which input to route to output 6.   
Output 7 Select which input to route to output 7.   
Output 8 Select which input to route to output 8.   
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Appendix 

C 
Technical specification 

The following is correct at time of publication. Components 
may change from time to time. 

Hardware specification: 
4u 19” rack mount chassis  
Min. 400W PSU Max. 550W PSU 
1Gb DDR registered RAM 
40Gb HDD (min. 7200 rpm) 
Video In: 768 x 576 PAL /NTSC 25fps/30fps composite or S-Video 
Video out: As video in + XGA @ 1024 x 768. 
Ethernet capability 
Dual 2+Gb processors 
Matrox 128Mb Graphics card 
Pinnacle PCTV capture 
 

Software specification: 
Microsoft Windows 2000 
QuickTime for Windows 
Sun Java Runtime 1.31 
Sun Java Media Framework 2.1.1c 
RADlite media server 
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Appendix 

D 
 

EC conformity 
 
 
 

EC Declaration of Conformity 
 
RADlite Version 4: 
This equipment conforms to harmonised standards as follows: 
 
EN 50081-1:1992 
EN 50082-1:1992 
EN 60950-1:1982 +A1 
 
 
Authorised Signatory 
 
 
 
 
 
 
 
 
 
 
 
 
Simon G Carter 
Managing Director 
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Appendix 

E 
 

Index 
Adding a new fixture ........................37 
Adding and removing Battens ..........39 
Adding and removing Pixel Range 

Fixtures .........................................39 
Adding files to the library .................12 
Adding Media to the show 

images 
palettes 

shapes 
videos 

text.................................31 
Adding patches and upgrades ...........46 
Addressing fixtures ...........................37 
Advanced Settings ............................44 
AMCap..............................................10 
Basic operation..................................11 
Changing the order of media.............34 
Changing the order of processing .....37 
Configuration utilities .......................10 
Configure 

DMX .............................................22 
Library...........................................24 
Performance ..................................23 
Video.............................................21 

Configuring the Display....................40 
Contacts.............................................46 
Control Settings ................................19 
Controlling the fixtures .....................38 
Creating a new show...................18, 35 
Creating a RADlite Show .................35 
Customer Support .............................48 
Display output...................................42 
Display Size ......................................43 
Distribution Centres ..........................48 
DMX 

configure .......................................22 

Receive .........................................21 
Send ..............................................21 

DMX Control....................................38 
DMX controller ..................................8 
Evaluation  Version ............................9 
Fader Sensitivity ...............................23 
Faders................................................38 
Features...............................................5 
Gap....................................................40 
Getting Started ..................................11 
Hardware set up ..................................7 
Hardware specification .....................61 
Installation and setup ..........................7 
JMStudio...........................................10 
Library ..............................................24 
Library Location ...............................36 
Local Control ..............................25, 38 
Matrox.......................21, 22, 42, 43, 44 
Matrox Adjustments .........................44 
Media 

images ...........................................29 
palettes ..........................................30 
shapes............................................30 
text ................................................31 
video .............................................30 

Monitor 
Grid ...............................................27 
Matrix ...........................................27 
Video.............................................27 

Opening a saved show ................19, 36 
Operating the PixelDrive system......40 
Optimising the graphics and video 

output ............................................42 
Patching ............................................38 
Performance......................................23 
Pixel Size ..........................................40 



 

PixelDrive 
features............................................5 

PixelDrive Fixture 
Overview.......................................14 

priority...............................................23 
Quicktime..........................................23 
R4 directory ........................................9 
RADlite Distributors ......................48 
RADlite Fixtures...............................12 
Recv ..................................................38 
Registration ...................................9, 24 
Removing a fixture ...........................37 
Removing media from a show ..........34 
Reporting errors ................................46 
Reset..................................................21 
Reset and Configure..........................38 
RLcanvas 

Channel Assignments....................52 
features............................................5 
overview........................................13 

RLgraphics 
Channel Assignments....................54 
features............................................5 
overview........................................14 

RLmask 
Channel Assignments....................56 
features............................................5 
overview........................................16 

RLsurface 
Channel Assignments....................58 
features............................................5 
overview........................................16 

RLSwitch 
overview........................................16 

RLText 
Channel Assignments....................57 
features............................................5 
overview........................................15 

RLwave 

Channel Assignments ...................59 
features............................................5 
overview .................................16, 17 

RS232 devices 
Channel Assignments ...................60 
features............................................5 
overview .......................................16 

Saving a show.............................19, 36 
serial number ....................................10 
Show Video ......................................20 
Shutting down the RADlite ..............17 
Smooth Lines ....................................23 
Software specification ......................61 
System files.........................................9 
Table of Contents................................2 
Technical specification .....................61 
The Configure Menu.........................21 
The Control Panel 

Menus ...........................................18 
The DMX window............................26 
The Edit Menu ..................................20 
The File Menu...................................18 
The Help Menu.................................24 
The Monitor window ........................26 
The Run Menu ..................................20 
The View Menu ................................20 
Troubleshooting................................46 
Types of media .................................29 

images 
palettes 

shapes 
videos 

messages .......................29 
Typical Uses .......................................5 
Using PixelDrive ..............................39 
Video Input .......................................22 
Video Modes.....................................13 
Video Output ..............................21, 43 
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